Agilent 6475 Triple Quad LC/MS System
User Guide
Notices

Document Identification
DocNo D0025685
DE22440912
October 2022

Copyright
© Agilent Technologies, Inc. 2022
No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or translation into a foreign language) without prior agreement and written consent from Agilent Technologies, Inc. as governed by United States and international copyright laws.
Agilent Technologies, Inc.
5301 Stevens Creek Blvd.
Santa Clara, CA 95051

Software Revision
This guide is valid for MassHunter 12.0, until superseded.

Instrument Manufacturing
Manufactured by Agilent Technologies Singapore Pte. Ltd.
No. 1 Yishun Avenue 7, Singapore 768923

Operating Temperature
Operating Temperature: 15°C to 35°C
Storage Temperature: -40°C to 70°C

Warranty
The material contained in this document is provided “as is,” and is subject to being changed, without notice, in future editions. Further, to the maximum extent permitted by applicable law, Agilent disclaims all warranties, either express or implied, with regard to this manual and any information contained herein, including but not limited to the implied warranties of merchantability and fitness for a particular purpose. Agilent shall not be liable for errors or for incidental or consequential damages in connection with the furnishing, use, or performance of this document or of any information contained herein. Should Agilent and the user have a separate written agreement with warranty terms covering the material in this document that conflict with these terms, the warranty terms in the separate agreement shall control.

Technology Licenses
The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with the terms of such license.

Restricted Rights Legend
U.S. Government Restricted Rights. Software and technical data rights granted to the federal government include only those rights customarily provided to end user customers. Agilent provides this customary commercial license in Software and technical data pursuant to FAR 12.211 (Technical Data) and 12.212 (Computer Software) and, for the Department of Defense, DFARS 252.227-7015 (Technical Data - Commercial Items) and DFARS 227.7202-3 (Rights in Commercial Computer Software or Computer Software Documentation).

Safety Notices

CAUTION
A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.

WARNING
A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed beyond a WARNING notice until the indicated conditions are fully understood and met.
Content

1 About this System  6

Sustainability Information  7
Packaging End-of-Life  7
Product End-of-Life  7

Agilent Regulatory Compliance Statement  8
CE Compliance  8
UK Compliance  9
Electromagnetic Compatibility  10
EMC Declaration for South Korea  11
Detachable Power Cord Declaration for Japan  11
Sound Emission Certification for Federal Republic of Germany  11
Waste Electrical and Electronic Equipment (WEEE) Directive  12

Technical Support  13
Agilent Community  13

2 Hardware Overview  14

6475A LC/TQ  15
Front view  15
Calibrant Delivery System  16
Side view  17

Instrument Status Indicator Lights  18

Instrument Status Indicators in Data Acquisition  19

Modes of Operation  20
ON mode  20
OFF mode  20
Standby mode  21

Ion Sources  22
Agilent Jet Stream (AJS) source  23
Electrospray Ionization (ESI) source  24
Atmospheric Pressure Chemical Ionization (APCI) source  25
Multimode Ionization (MMI) source  26
Content

3 Tuning  27

About Tuning  28
Autotune and Checktune  28
Starting the Instrument  29
Calibrating the LC/TQ (Checktune)  30
Calibrating the LC/TQ (Autotune)  31
Generating a Detailed Tune Report  32
Customizing the Actuals Window  33
Scheduling a Checktune  34
Scheduling an Autotune  35
Monitoring Baseline and Adjust Plot  36
Adjusting the plot in any of the following ways:  36
Fixing Spray Stability EMF  37

4 Basic Operation  38

Starting Up and Shutting Down the Instrument  39
Starting in Standby mode  39
Turning off the instrument  39
Starting the Data Acquisition Software  41
Data Acquisition Windows  42
Preparing the LC Modules  46
Preparing the Triple Quad LC/MS  50
Performing a Checktune or Autotune  50
Switching LC stream to MS  50
Monitoring MS baseline and spectral displays  50
Viewing the system logbook for events and errors  51
## Content

**Setting Up and Running an Acquisition Method**  52  
**Reviewing Results with Qualitative Analysis**  58  
**Analyzing Data with Quantitative Analysis**  59

### 5 Maintenance  60

**Routine Tasks**  61  
Calibrant Delivery System and Divert Value  61  
Sources  62  
Nebulizer  65

**Periodic Tasks**  66  
Calibrant Delivery System and Divert Value  66  
Sources  67  
Nebulizer  73  
Corona Needle  78  
Ion Injector  80  
Rough Pump  83

**Disinfection**  89
1

About this System

Sustainability Information  7
Agilent Regulatory Compliance Statement   8
Technical Support   13
Sustainability Information

Packaging End-of-Life

The Agilent 6475 triple quadrupole LC/MS system is packaged using cardboard and a polyethylene bag. In the US, the cardboard is readily recyclable; while the plastic bag is recyclable, the infrastructure is not available in the majority of the market. In the US, Agilent is enrolled in the How2Recycle program to facilitate the communication of material recycling instructions. In select countries, Agilent participates in the EU/UK Green DOT Package Recycling Program to support the take-back and responsible management of the packaging materials at their end-of-life. In the remaining EU countries, the cardboard is readily recyclable while the plastic bag is recycled, landfilled or incinerated depending on the country and its available infrastructure.

Product End-of-Life

Agilent offers a take-back program for its 6475 triple quadrupole LC/MS system customers in US, EU and UK markets.
CE Compliance

Your Agilent instrument has been designed to comply with the requirements of the applicable directives of the European Union, such as Electromagnetic Compatibility (EMC) Directive, Low Voltage Directive (LVD), Machinery Directive (MD), RoHS Directive, etc.

Agilent has confirmed that each product complies with the relevant Directives by testing samples against the harmonized EN (European Norm) standards published on the Official Journal of the European Union (OJEU).

Proof that a product complies with these directives is indicated by:

- the CE Marking appearing on the rear of the product, and
- the documentation package that accompanies the product containing a copy of the Declaration of Conformity. The Declaration of Conformity is the legal declaration by Agilent that the product complies with the relevant directives listed above, and shows the EN standards to which the product was tested to demonstrate compliance.
UK Compliance

Your Agilent instrument has been designed to comply with the requirements of the applicable regulations of the United Kingdom, such as The Electromagnetic Compatibility Regulations 2016, The Electrical Equipment (Safety) Regulations 2016, The Supply of Machinery (Safety) Regulations 2008, The Restriction of the Use of Certain Hazardous Substances in Electrical and Electronic Equipment Regulations 2012, etc.

Agilent has confirmed that each product complies with the relevant Regulations by testing samples against the designated standards published on GOV.UK.

Proof that a product complies with these regulations is indicated by:

• the UKCA Marking appearing on the rear of the product, and
• the documentation package that accompanies the product containing a copy of the Declaration of Conformity. The Declaration of Conformity is the legal declaration by Agilent that the product complies with the relevant regulations listed above, and shows the designated standards to which the product was tested to demonstrate compliance.
Electromagnetic Compatibility

This product conforms to the following regulations on Electromagnetic Compatibility (EMC) and Radio Frequency Interference (RFI):

- CISPR 11/EN 55011: Group 1, Class A
- EC/EN 61326-1
- AUS/NZ
- Canada ICES-001 (This ISM device complies with Canadian ICES-001. Cet appareil ISM est conforme à la norme NMB-001 du Canada).

**Group 1 ISM equipment**  Group 1 contains all Industrial, Scientific and Medical (ISM) equipment in which there is intentionally generated and/or used conductively coupled radio-frequency energy which is necessary for the internal functioning of the equipment itself.

**Class A equipment**  This equipment is suitable for use in all establishments other than domestic and those directly connected to a low voltage power supply network which supplies buildings used for domestic purposes.

This device complies with the requirements of CISPR11, Group 1, Class A as radiation professional equipment. Therefore, there may be potential difficulties in ensuring electromagnetic compatibility in other environments, due to conducted as well as radiated disturbances.

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try one or more of the following measures:

1. Relocate the radio or antenna.
2. Move the device away from the radio or television.
3. Plug the device into a different electrical outlet, so that the device and the radio or television are on separate electrical circuits.
4. Make sure that all peripheral devices are also certified.
5. Make sure that appropriate cables are used to connect the device to peripheral equipment.
6. Consult your equipment dealer, Agilent Technologies, or an experienced technician for assistance.

Changes or modifications not expressly approved by Agilent Technologies could void the user’s authority to operate the equipment.
EMC Declaration for South Korea

사용자안내문
This equipment has been evaluated for its suitability for use in a commercial environment. When used in a domestic environment, there is a risk of radio interference.
이 기기는 업무용 환경에서 사용할 목적으로 적합성평가를 받은 기기로서 가정용 환경에서 사용하는 경우 전파간섭의 우려가 있습니다.
※ 사용자 안내문은 "업무용 방송통신기자재 " 에만 적용한다.

Detachable Power Cord Declaration for Japan

電源コードセットの取扱いについて（日本国内向け）
製品には、同梱された電源コードセットをお使いください。同梱された電源コードセットは、他の製品では使用できません。
Notice - The power cords for Japanese market
Your product must only use the power cord that was shipped with this product. Do not use this power cord with any other product.

Sound Emission Certification for Federal Republic of Germany

Sound pressure
Sound pressure Lp < 70 dB(A) according to DIN EN ISO 7779.

Schalldruckpegel
Schalldruckpegel LP < 70 dB(A) nach DIN EN ISO 7779.
Waste Electrical and Electronic Equipment (WEEE) Directive

This product complies with the European WEEE Directive marking requirements. The affixed label indicates that you must not discard this electrical/electronic product in domestic household waste.

NOTE

Do not display of in domestic household waste.
To return unwanted products, contact your local Agilent office or see https://www.agilent.com for more information.
Technical Support

To find your local sales and support contact, visit the following page:

For technical support, visit the following page:
https://www.agilent.com/en/support

Agilent Community

To get answers to your questions, join over 10,000 users in the Agilent Community. Review curated support materials organized by platform technology. Ask questions to industry colleagues and collaborators. Get notifications on new videos, documents, tools, and webinars relevant to your work.

https://community.agilent.com
2 Hardware Overview

6475A LC/TQ  15
Instrument Status Indicator Lights  18
Instrument Status Indicators in Data Acquisition  19
Modes of Operation  20
Ion Sources  22
Front view

Figure 1. Front view of 6475A LC/TQ
Calibrant Delivery System

Figure 2. Calibrant delivery system
Figure 3. Side view of 6475A LC/TQ
## Instrument Status Indicator Lights

### Table 1 Status indicator lights on instrument

<table>
<thead>
<tr>
<th>Instrument State</th>
<th>Status LED</th>
<th>Power Switch LED</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOTING (FPGA Loaded)</td>
<td>Blinking Yellow</td>
<td>Yellow</td>
</tr>
<tr>
<td>ACQUISITION</td>
<td>Blinking Green</td>
<td>Green</td>
</tr>
<tr>
<td>BOOTTING (LINUX Loaded)</td>
<td>Yellow</td>
<td>Green</td>
</tr>
<tr>
<td>FAULT</td>
<td>Red</td>
<td>Green</td>
</tr>
<tr>
<td>PUMPING DOWN</td>
<td>Blinking Yellow</td>
<td>Green</td>
</tr>
<tr>
<td>VENTING</td>
<td>Blinking Red</td>
<td>Yellow</td>
</tr>
<tr>
<td>STANDBY</td>
<td>Yellow</td>
<td>Green</td>
</tr>
<tr>
<td>Vented</td>
<td>Red</td>
<td>Yellow</td>
</tr>
<tr>
<td>IDLE</td>
<td>Yellow</td>
<td>Green</td>
</tr>
<tr>
<td>POWERING DOWN</td>
<td>Off</td>
<td>Blinking Yellow</td>
</tr>
<tr>
<td>BACKGROUND SCAN</td>
<td>Green</td>
<td>Green</td>
</tr>
<tr>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
</tbody>
</table>
Instrument Status Indicators in Data Acquisition

In MassHunter Data Acquisition, the Instrument Status window indicates the state of the instrument.

- Gray - Not Connected: The instrument is configured with the system and available to use, but the AIC/workstation is not currently running. The amount of time for an instrument to reach the Idle state depends on each instrument.

- Yellow - Unknown: The device is in an unknown run state.

- Dark Yellow - Not Ready: The instrument is connected but is not ready to run (due to not reaching the correct temperature or pressure required by the method, for example).

- Green - Idle: The instrument is on and ready to process samples.

- Teal - Standby: The instrument is in a standby/sleep state.

- Purple - Pre-run/Injecting: The instrument is on and is preparing to start acquisition.

- Blue - Running, Post Run: The instrument is currently collecting data.

- Orange - Tuning: The instrument is in the process of adjusting MS parameters.

- Light Orange - Not Ready: The device is not ready.

- Red - Instrument Error: The instrument has an error and cannot process samples.

- Blank - Disconnected: The connection to the instrument has been closed.
Modes of Operation

There are three standard modes of operation: ON, OFF, and Standby.

**ON mode**

ON is the fully operational status of the system. The instrument and the source are on. When MassHunter Data Acquisition is opened, the instrument automatically goes into ON mode.

**OFF mode**

When in the powered OFF state, the system is vented and the instrument is turned off to allow for maintenance or to prepare for long periods of non-use.
Standby mode

Standby mode lets the instrument remain idle for a period lasting from minutes to days. Put the instrument in Standby mode when it is not in use or when you want to change the ion source.

When the instrument is in Standby mode:

- The source interface is ON, the drying gas remains heated, and nebulizer flows are maintained.
- The source and ion optics voltages are turned OFF, and the mass spectrometer is not sending spectra to the computer.
- The LC/MS high voltage electronics are ON.
- For APCI and multimode sources: The vaporizer gas heaters are turned down.
- For the Agilent Jet Stream (AJS) source: The sheath gas temperature, drying gas flow, and drying gas temperature are reduced.
- The spray chamber high voltages are turned OFF.
- The mass spectrometer stops generating spectra.
Ion Sources

The following are supported ion sources:

- **“Agilent Jet Stream (AJS) source” on page 23**
- **“Electrospray Ionization (ESI) source” on page 24**
- **“Atmospheric Pressure Chemical Ionization (APCI) source” on page 25**
- **“Multimode Ionization (MMI) source” on page 26**
- **“Simultaneous ESI and APCI capability and high LC flow rate compatibility (up to 2 mL/min) means more compounds can be detected in less time with the Agilent Multimode source.” on page 26**

For ion source maintenance, see **“Sources” on page 62**.
Agilent Jet Stream (AJS) source

The Agilent Jet Stream (AJS) source uses the same ionization technique as the Electrospray source.

The AJS source uses Thermal Gradient Focusing Technology, which is a process in which super-heated nitrogen (N₂) is used to improve ion generation and desolvation.

AJS source improves sensitivity 5x or more for many small-molecule compounds that undergo electrospray ionization.

Figure 4. AJS cover, ion source, and spray shield
Electrospray Ionization (ESI) source

Electrospray relies in part on chemistry to generate analyte ions in solution before the analyte reaches the mass spectrometer. The LC eluent is sprayed (nebulized) into a chamber at atmospheric pressure in the presence of a strong electrostatic field and heated drying gas.

The electrostatic field causes further dissociation of the analyte molecules. The heated drying gas causes the solvent in the droplets to evaporate. As the droplets shrink, the charge concentration in the droplets increases. Eventually, the repulsive force between ions with like charges exceeds the cohesive forces and ions are ejected (desorbed) into the gas phase. These ions are attracted to and pass through a capillary sampling orifice into the mass analyzer.

![Figure 5. ESI cover, ion source, and spray shield](image)
Atmospheric Pressure Chemical Ionization (APCI) source

In Atmospheric Pressure Chemical Ionization (APCI), the LC mobile phase is sprayed through a heated vaporizer (typically 250°C to 400°C) at atmospheric pressure. The heat vaporizes the liquid. The resulting gas-phase solvent molecules are ionized by electrons discharged from a corona needle.

The solvent ions then transfer charge to the analyte molecules through chemical reactions (chemical ionization). The analyte ions pass through a capillary sampling orifice into the mass analyzer. APCI is applicable to a wide range of polar and nonpolar molecules.

APCI rarely results in multiple charging, so APCI is typically used for molecules smaller than 1,500 u.

Because high temperatures are also involved, APCI is not appropriate for analysis of large biomolecules. APCI is used with normal-phase chromatography more often than electrospray is because the analytes are usually nonpolar.

Figure 6. APCI cover, ion source, and spray shield
Multimode Ionization (MMI) source

The Multimode source for LC/MS can simultaneously do ESI and APCI ionization. The Multimode source can operate in ESI mode only, in APCI mode only, or in mixed ESI/APCI mode. This technology significantly improves the speed, accuracy and productivity of high-throughput screening in drug discovery and other research applications.

High-throughput screening is used to analyze large numbers of chemical compounds rapidly and with high sensitivity. In order to be analyzed by mass spectrometry, all compounds must be converted into ions. Since not all molecules respond to the same mode of ionization, multiple ionization sources were developed to facilitate high-throughput screening.

Simultaneous ESI and APCI capability and high LC flow rate compatibility (up to 2 mL/min) means more compounds can be detected in less time with the Agilent Multimode source.
3 Tuning

About Tuning 28
Starting the Instrument 29
Calibrating the LC/TQ (Checktune) 30
Calibrating the LC/TQ (Autotune) 31
Generating a Detailed Tune Report 32
Customizing the Actuals Window 33
Scheduling a Checktune 34
Scheduling an Autotune 35
Monitoring Baseline and Adjust Plot 36
Fixing Spray Stability EMF 37
About Tuning

Autotune and Checktune

A Checktune can be used to determine if the tuning mix ion masses are properly assigned and if the response or sensitivity of these ions is within expectations. In other words, a Checktune verifies peak width and mass axis to make sure they are correct before you start your acquisition. This check tune takes approximately 3 minutes to run in each polarity. See “Calibrating the LC/TQ (Checktune)” on page 30.

Autotune only needs to run after preventative maintenance or if you find a problem with Checktune. You only mark Tune from factory default if regular Autotune fails, or if the tune file was corrupted. An Autotune can take approximately 15 to 20 minutes for each polarity. Everything is automatic since the tuning mix is delivered by the calibrant delivery system, which is switched on automatically during the tune. See “Calibrating the LC/TQ (Autotune)” on page 31.
Starting the Instrument

1. Follow the procedures in “Starting Up and Shutting Down the Instrument” on page 39 to begin operation of the instrument.

2. Display the Instrument Status window if it is not visible in MassHunter Data Acquisition software, in one of the following ways:
   - Open a layout that includes the Instrument Status window.
   - On the Ribbon, click Instrument Status in the Windows section.

3. Right-click the LC/TQ device pane in the Instrument Status window, and select On. You can also click the button in the title for the TQ Device Pane in the Instrument Status window.

4. Monitor baseline and adjust plot if necessary. See “Monitoring Baseline and Adjust Plot” on page 36.
Calibrating the LC/TQ (Checktune)

A Checktune can be run with the following ion sources: ESI, AJS ESI, MMI, and APCI. The MMI source is only supported with the Ultivo and 6475 LC/TQs. Checktune is automatically run in both positive polarity and negative polarity.

1. If necessary, open the Method Editor window.
2. Click the TQ tab.
3. Click the Tune > Autotune section in the left pane.
4. Click in the toolbar in the Autotune section. This button locks control of the TQ instrument. You cannot start a single sample run or a worklist when Tune has control of the TQ instrument.
5. Click in the toolbar in the TQ Autotune section.
6. When the tune completes, review the report.
7. Click in the toolbar to release control of the TQ instrument.
Calibrating the LC/TQ (Autotune)

An Autotune can be run with the following ion sources: ESI and AJS ESI. The MMI source is only supported with the Ultivo and 6475 LC/TQs. Autotune is automatically run in both positive polarity and negative polarity.

1. If necessary, open the Method Editor window.
2. Click the TQ tab.
3. Click the Tune > Autotune section.
4. Click in the toolbar in the Autotune section. This button locks control of the LC/TQ instrument. You cannot start a single sample run or a worklist when Tune has control of the LC/TQ instrument.
5. Click in the toolbar in the LC/TQ Autotune section.
6. When the tune completes, review the report.
7. Click in the toolbar to release control of the LC/TQ instrument.
Generating a Detailed Tune Report

A detailed tune report can be generated after you have run Autotune or Checktune. This is only supported on Ultivo and 6475 LC/TQs.

1. If necessary, open the Method Editor window.
2. Click the TQ tab.
3. Click the TQ > Autotune section in the left pane.
4. Click in the toolbar in the Autotune section. This button locks control of the TQ instrument. You cannot start a single sample run or a worklist when Tune has control of the TQ instrument.
5. Click the Generate Detailed Tune Report icon in the toolbar in the TQ Autotune section. If this button is not available, then you need to run either a Checktune or an Autotune first.
6. Click in the toolbar to release control of the TQ instrument.
Customizing the Actuals Window

Current instrument conditions are displayed in the Actuals window. The Actuals window can be customized to display instrument conditions that you may want to view during tuning.

1. Select **View > Actuals** to display the Actuals window.
2. Right-click the **Actuals** window and select **Setup** to display other instrument conditions.
   - a. Click the + icon to the left of the device of interest to see a list of the instrument parameters for that device. Only configured devices will be shown in the list.
   - b. Select the parameters of interest, and click the -> button. Repeat this step for all the parameters you want to view.
   - c. Select any parameter in the **Parameters to display** list that you do not want included, and click the <- button.
4. Customize the background color and the text color for any parameters in the **Parameters to display** list.
5. Add any conditional ranges to the parameters. If the parameter is outside of the range specified, then the background of that parameter in the Actuals window is turned to red.
6. Click **OK** when you finish selecting parameters. The parameters you selected appear in the Actuals window. Note that the customizations you have made will remain, even if you close the MassHunter Data Acquisition software and reopen it.
Scheduling a Checktune

To specify to run a Checktune automatically,
1  If needed, display the Instrument Status window. On the tool ribbon, click Instrument Status.
2  Right-click the TQ device in the Instrument Status window.
3  Click Schedule Tune. The Schedule Tune Dialog Box opens.
4  Select Checktune in the left pane. The right pane shows the information for scheduling a Checktune.
5  Click the Scheduling slider to switch Scheduling on.
6  Select either Weekly or Monthly.
7  Select other options to indicate how often to schedule the Checktune.
8  Click Save.
Scheduling an Autotune

To specify to run an Autotune automatically,
1  If needed, display the Instrument Status window. On the tool ribbon, click Instrument Status.
2  Right-click the TQ device in the Instrument Status window.
3  Click Schedule Tune. The Schedule Tune Dialog Box opens.
4  Select Autotune in the left pane. The right pane shows the information for scheduling an Autotune.
5  Click the Scheduling slider to switch Scheduling on.
6  Select either Weekly or Monthly.
7  Select other options to indicate how often to schedule the Autotune.
8  Click Save.
Monitoring Baseline and Adjust Plot

The detector signals and various instrument parameters can be displayed in the Chromatogram Plot window. You can select the signals and adjust their display characteristics as follows. The customizations you make to the plot remain, even if you close the MassHunter Data Acquisition software program and reopen it.

1. Display the Chromatogram Plot window if it is not visible in the MassHunter Data Acquisition software program.
2. Right-click the Chromatogram Plot window, and select Change. The Edit Signal Plot dialog box appears.
3. Select the signal to monitor and set the X and Y range for the plot.
4. To add other MS signals, such as EICs, setpoints, and actuals, select these in the TQ Chromatograms Section in the Method Editor window.
5. Click OK to close the Edit Signal Plot dialog box.

Adjusting the plot in any of the following ways:

1. Click and drag the cursor to zoom into the plot.
2. Click Autoscale XY in the shortcut menu to automatically adjust the scale to show the entire spectrum.
3. Right-click the Chromatogram Plot window to access these other options for changing the display:
   • Click Freeze to temporarily stop the automatic scrolling of data along the x-axis.
   • Click Zoom Out to undo all zoom operations.
   • Click Undo Zoom to undo the last zoom operation.
Fixing Spray Stability EMF

If the Spray stability status is active, you should inspect, adjust or flush your nebulizer to ensure a stable spray from the CDS to the nebulizer. An unstable spray may lead to issues with tuning and sample analysis.

1. Inspect, adjust, or flush your nebulizer. If necessary, replace the nebulizer needle or nebulizer.

2. Follow the procedure to "Calibrating the LC/TQ (Checktune)" on page 30 or "Calibrating the LC/TQ (Autotune)" on page 31. The spray stability is reevaluated as part of a tune. If it within the acceptable range, the EMF warning should be removed following completion of the tune.
4 Basic Operation

Starting Up and Shutting Down the Instrument 39
Starting the Data Acquisition Software 41
Preparing the LC Modules 46
Preparing the Triple Quad LC/MS 50
Setting Up and Running an Acquisition Method 52
Reviewing Results with Qualitative Analysis 58
Analyzing Data with Quantitative Analysis 59

The roadmap below shows you the steps to set up and run a batch of samples from start to finish. Follow the instructions on the next pages to get started and to learn where to find the information to help you with each step in this roadmap.
Starting Up and Shutting Down the Instrument

Starting in Standby mode

1. Check that nitrogen gas for the drying gas and for the collision cell are turned on.
2. Turn on the power for the computer and monitor.
3. Check that the instrument and rough pump are plugged into a power outlet.
4. Press the front power switch on the instrument.

   The vacuum system automatically starts to pump down the instrument, and the electronics are turned on. The system card books up and the firmware starts.

Turning off the instrument

Before you turn off the instrument, complete any acquisition steps and save your data.

**CAUTION**

To prevent instrument damage, always vent the system before pressing the power button.

**WARNING**

Do not touch the spray shield and related spray chamber components. They are likely to be hot.

1. Turn off the solvent flow.
   
   If you have any analyte in any of the components in the sample delivery system, flush the delivery system with pure solvent before you continue.
2. Check that the ballast valve on the rough pump is closed (if applicable).
3 In MassHunter Data Acquisition, in the Tune view or context, right-click the TQ icon in the Instrument Status window and select Vent to vent the system. Click Yes to continue.

When you vent the system, the following occurs:

- The spray chamber high voltages, the drying gas heater, the nebulization flow, the detector, and other lens voltages are turned OFF.
- The drying gas flow is set to Standby.
- If the APCI source is installed, the vaporizer heater is also turned OFF.
- If the installed source is an Agilent Jet Stream source, the sheath gas heater is also turned OFF.
- The Rough Pump turns OFF when the turbo speed is below 20 percent.

4 Wait until the instrument completely vents (reaching 760 Torr).

5 Close the Data Acquisition program and shut down the computer.

6 Press the power switch located in the lower left front corner of the instrument.

7 Unplug the main power cable behind the service panel. This action prevents the turbo pump components from overheating.
Starting the Data Acquisition Software

The instructions below include the following assumptions:

- The hardware and software are installed.
- The instrument is configured. For information on configuring your instrument, refer to the MassHunter Control Panel online Help.
- The LC modules and the Triple Quad LC/MS are turned on, but the LC pump is not running.

After installation, all of the Agilent MassHunter Workstation Software icons on your desktop. To start the Data Acquisition program, double-click the Data Acquisition icon on your desktop, or select Windows Start > Agilent MassHunter LCMS Acq > Data Acquisition. The Data Acquisition window appears.

**NOTE**

When Data Acquisition opens, the software engines automatically start. If you need to restart them, right-click the Acq System Launcher icon in the system tray, and click Start Engines.

If you have recently changed LC modules, remember to configure the instrument again. See the Installation Guide for instructions.
Basic Operation

Data Acquisition Windows

When the Data Acquisition program opens, the main window appears. Almost all of your work is done within the windows of this main window. These windows provide the tools to set up acquisition methods, run samples interactively or automatically, monitor instrument status, monitor runs, and tune the instrument.

Showing and hiding the windows

Up to seven windows can be shown at a time. At least one window must be shown. To show or hide a window, you click the commands in the View menu. You can also hide a window by clicking the X icon in the upper right corner of the window.

When you click a window, the title of the active window changes to a different color. Press F1 to obtain help on the active window. Drag a window border to resize the window. If you double-click the title of the window, the window “floats” outside of the main window. Double-click the title bar again to “dock” the window.
Basic Operation
Data Acquisition Windows

**Instrument Status window**

This window displays the status of each device configured with the instrument: Error, Not ready, Pre-run, Post-run, Running, Injecting, Idle, Offline, or Standby. You also set non-method control and configuration parameters for the LC devices and the MS instrument.

This window displays the current status of each device both as text and by its color-coding. See “Instrument Status Indicators in Data Acquisition” on page 19.

**Actuals window**

This window displays the current value of selected instrument parameters. See “Set up to view real-time parameter values (actuals).” on page 47 for more information.

**Chromatogram Plot window**

This window displays the chromatogram plots in real time. These plots can be user-defined signals and/or instrument parameters. You select the plots in the Chromatogram tab in the QQQ tab in the Method Editor window.
Basic Operation
Data Acquisition Windows

Spectrum Pane window
This window displays the spectral plot in real time. A different tab is available for different devices.

Method Editor window
In this window, enter acquisition parameters for the method. If you click View in the QQQ tab, then you can see the tune values in the Tune Parameters dialog box.

Sample Run window
In this window, enter sample information to run individual samples interactively, and you can start a single sample run. Specify an Override DA Method and select either Both Acquisition and DA or DA Only for the Method Type, and then Data Analysis is run as part of the method.
Worklist window

In this window, enter sample information for multiple samples. When you run the worklist, the samples are automatically run in the order listed in the worklist. Select whether to run **Acquisition Only**, to run **Both Acquisition and DA**, or to run **DA only** by selecting one of these options for the **Part of method** to run in the Worklist Run Parameters dialog box.
Preparing the LC Modules

Read and follow the instructions in the online Help for each of the tasks in the checklist described on the following pages. While you condition or equilibrate the column, you can tune the Triple Quad LC/MS.

1  Switch LC stream to **Waste**.

   When you are not acquiring data, you switch the direction of the LC stream away from the MS ion source and to waste.

   If you have the LC connected to a VWD or DAD, you can still monitor the fluctuations of the VWD or DAD real-time chromatogram before a run.
   
   a  Right-click the **QQQ** device in the Instrument Status window.
   
   b  Select **LC > Waste**.

2  Purge the LC pump. Follow the directions for purging the pump in the *User Guide* for your pump.

3  Set up to condition or equilibrate the column.
   
   a  Type **LC parameters**, and click **Apply** in the toolbar to download them to the LC.
b Right-click an LC module in the Instrument Status window and select one of the commands to change any non-method control parameters, if needed.

![Instrument Status Window](image)

```
Instrument Status
```

Right-click the `Control...` list to see the Setup command.

c Monitor the baseline and adjust the plot to make sure the column is equilibrated and the baseline stable. (See step 4 and step 5 in this procedure.)

4 Set up to view real-time parameter values (actuals).

As you prepare for a run and during a run, you want to see the actual values of the instrument parameters. Do this in the Instrument Status window.

a Right-click the **Actuals** list to see the Setup command.

![Actuals List](image)
b Select **Setup** to open the list of Actuals available for monitoring.

![Actuals Selection Dialog]

<table>
<thead>
<tr>
<th>Available Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Calibrant</td>
</tr>
<tr>
<td>- Capillary Current</td>
</tr>
<tr>
<td>- Capillary Voltage</td>
</tr>
<tr>
<td>- Chamber Current</td>
</tr>
<tr>
<td>- Collector Gas</td>
</tr>
<tr>
<td>- Conversion State</td>
</tr>
<tr>
<td>- Corona Voltage</td>
</tr>
<tr>
<td>- Emitter Valve</td>
</tr>
<tr>
<td>- Error Text</td>
</tr>
<tr>
<td>- Firmware Version</td>
</tr>
<tr>
<td>- Gas Temperature</td>
</tr>
<tr>
<td>- High Vac</td>
</tr>
<tr>
<td>- Instrument State</td>
</tr>
<tr>
<td>- Ion Mode</td>
</tr>
<tr>
<td>- Ion Polarity</td>
</tr>
<tr>
<td>- Ion Source</td>
</tr>
<tr>
<td>- MS1 Heater</td>
</tr>
<tr>
<td>- MS2 Heater</td>
</tr>
<tr>
<td>- Nebulizer</td>
</tr>
<tr>
<td>- Not Ready Text</td>
</tr>
<tr>
<td>- Pump1 Current</td>
</tr>
<tr>
<td>- Ready State</td>
</tr>
</tbody>
</table>

![Parameters to display]

<table>
<thead>
<tr>
<th>Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>TQ: Not Ready Test</td>
</tr>
<tr>
<td>TQ: Run State</td>
</tr>
<tr>
<td>TQ: High Vac</td>
</tr>
<tr>
<td>TQ: Gas Temperature</td>
</tr>
<tr>
<td>TQ: Rough Vac</td>
</tr>
<tr>
<td>TQ: Turbo Speed</td>
</tr>
<tr>
<td>TQ: Firmware Version</td>
</tr>
<tr>
<td>TQ: Pump1 Current</td>
</tr>
<tr>
<td>TQ: Instrument State</td>
</tr>
</tbody>
</table>

![Color Formatting]

- Background Color
- Text Color
- Reset

<table>
<thead>
<tr>
<th>Conditional Formatting for Selected Parameter Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lower Unit</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

![Clear All Up Down Move To Top]

- Clear All
- Up
- Down
- Move To Top

Add all the parameter values you intend to monitor, and click **OK**.

Parameters that you may want to monitor include MS values (such as heater, and vacuum pressure) or LC values (such as binary pump, column, DAD, etc.) Set the background and text color for each parameter, and set a range for the parameters which are numbers. If the value of the parameter is not within the limits which you entered, then the background of the parameter is set to red.
5 Set up real-time plot displays.

As you condition the column, you can set up the displays to monitor the effluent.

a Right-click the chromatogram plot, and select **Change**.

![Chromatogram Plot](image)

b In the **Edit Signal Plot** dialog box, select the type of display signal.
Preparing the Triple Quad LC/MS

Performing a Checktune or Autotune

See Chapter 3, “Tuning”.

Switching LC stream to MS

After you condition the column and tune the instrument, you switch the LC stream from Waste to MS. See “Switch LC stream to Waste.” on page 46 for how to do this.

Monitoring MS baseline and spectral displays

If you did not monitor the LC baseline with a VWD or DAD, make sure that the instrument baseline is stable, and no spectra of interfering intensity appear in the display.

If you did monitor the LC baseline with a VWD or DAD, you change back to the default instrument displays.

1. Right-click the chromatogram plot, and click Change.
2. Select the MS signal, and click OK.
Viewing the system logbook for events and errors

As you prepare the instrument, you may run into an error that you want to troubleshoot. You do this through the System Logbook Viewer.

- Click **Log** in the toolbar of the Data Acquisition window, and view the logged events.
- Or click **Tools > System Logbook Viewer**.
- Or right-click **Log** in the system taskbar. First, click **Enable Notification**. Then, right-click **LOG** and select **Configure**. The system can notify you of new errors and warning by showing messages from the taskbar.

When the System Logbook Viewer is open, you can select the time period to keep System Logbook entries. You can set the value from 1 week to 1 year. To do this, you click **Tools > Purge Settings**. The **System logbook purge** dialog box opens.
Basic Operation
Setting Up and Running an Acquisition Method

Setting Up and Running an Acquisition Method

1. Set up the method:
   a. Type the values and settings for each of the tabs below.
   b. Optional. To download the settings to the instrument, click Apply.
   c. To save the method, click Save As.
   d. Name the method and click OK.

2. Enter values for all of the LC modules configured for the instrument.

3. Enter the TQ parameter values.
   a. Select the Scan Type from the list in the Time segments table. The Scan segments table is cleared when you change the Scan Type. The parameters available on the right change depending on the Scan Type for the selected Time segment.

   If you are changing the Scan Type from MRM to Dynamic MRM or to Triggered MRM, you can copy and paste the transitions from the original Scan segments table to the Clipboard and then to the new Scan segments table. See the online Help for more information.

   Make sure when you type the MS parameters on the next page that the tune file is the one that you want to use with the acquisition.
4 Basic Operation
Setting Up and Running an Acquisition Method

b On the TQ tab, enter any Acquisition values you want to change. You can enter multiple **Scan segments**.

You cannot set the fragmentor voltage in Acquisition if the instrument type is an Agilent 6490 or an Agilent 6495. It always uses the value in the tune file.

4 Set up to change instrument parameters with segments and scans:

a To add a segment, click the **Add Row** or **Insert Row** icons.

b Enter the parameters for each Scan segment.

5 Set up signals for the Chromatogram plot:

a Click **Chromatogram**.

b Select the Chromatogram Type, and type other plot values.
6 Set up the **Stored instrument curves** in the Instrument tab. In the Qualitative Analysis program, you can display these values in the MS Actuals window for the current spectrum. With the instrument, the values in the MS Actuals window in the Qualitative Analysis program are the values that you save in the Instrument tab.

   a Click **Instrument**.

   b Select the Stored instrument curves. These curves can be shown in the Chromatogram Results window in the Qualitative Analysis program. The values can be seen in the MS Actuals window.

7 Set up the data analysis (DA) parameters.

A method can contain Qualitative Analysis parameters, Quantitative Analysis parameters, or a combination. The **Qual Automation** check box is marked on the Qual tab and the **Quant Automation** check box is marked on the Quant tab.

   a Select the DA tab.

   b **Optional.** On the Qual tab, mark the **Qual Automation** check box. The name of the current Qualitative Analysis method is shown in the box. If you want to change the Qualitative Analysis method that is connected, click **browse** to select a different method. When the Data Acquisition method is saved, the Qualitative Analysis method that you selected is copied or linked to the Data Acquisition method.
Optional. On the Quant tab, mark the Quant Automation check box. The name of the current Quantitative Analysis method is shown in the list. If you want to change the Quantitative Analysis method that is connected, click browse to select a different method. When the Data Acquisition method is saved, the Quantitative Analysis method that you selected is copied or linked to the Data Acquisition method.

Optional. Mark the Generate Report check box on the Quant tab. Then, you select the Method Path / Template File to use. If you want to print the report, mark the Print to default printer check box. You can also mark the Publish check box to create a CSV file, a TXT file, or a PDF file.

Set up the Properties for this method.

Select the Properties tab.
Click browse to select the Pre Run Script.
Click browse to select the Post Run Script.
Type the Description for this method.

Save the method.
Click Save As or Save.
If User Management & Audit Trail or Compliance (with ECM) is enabled, enter the Reason for creating a new version of this method. Click OK.
If necessary, name the method and click OK.

Set up and run interactive samples:
Click the Sample Run window.
Enter the Sample Name, the Data File Name, the Path and other values.
c Enter the **Additional Information**. If needed, change the value of the parameters in the **Additional Information** list.

Run a Data Analysis method from this window by selecting **Both Acquisition and DA** or **Acquisition Only** for the **Part of Method to run**. In addition, you have to set **Override DA method** to indicate which Data Acquisition method contains the DA (Data Analysis) method to execute. You always have to do this.

d To start the single sample run, click **Run** in the Sample Run window.

The single sample can be run in either locked or unlocked mode. When the mode is locked, no one can change the method or sample parameters during a run. You also cannot overwrite this data file in the Data Acquisition program. The **Lock** button in the main toolbar indicates that locked mode is on.

11 Set up and run worklists.

a Click **Worklist** to show the Worklist window.

b Click **Add Multiple Samples**. The **Add Multiple Samples** dialog box opens.

c Enter all the information on the Sample Information tab.
d) On the **Sample Position** tab, specify the sample vial locations (make sure the specific sample tray type has been configured by right-clicking the autosampler device image).

![Sample Position Tab](image)

...To set up the worklist run, click **Worklist Run Parameters**.

...On the **Run Parameters** tab, type the paths for the method.

...On the **Data File Settings** tab, enter or select the folders for the data files. Select the **File Naming** options.

...On the **Additional Parameters** tab, review the information and click **OK**.

...To start the worklist, click **Run Worklist**.

You run the worklist in locked or unlocked mode. When the mode is locked, no one can change the method or the worklist while the worklist is running.

---

**NOTE**

To use an acquisition method that has a different data analysis (DA) method than the method entered in the worklist, show the column called **Override DA Method** in the worklist by using the **Show/Hide/Order Columns** dialog box. In this column, type the name of another method containing the DA parameters you want to use for the sample. The DA part of this method is used instead of the DA part of the current method.

You can also type the name of this method in the **Add Multiple Samples** dialog box.
Reviewing Results with Qualitative Analysis

Use the Qualitative Analysis program to do these tasks and more:

- Review results for acquisition method development
- Select the most appropriate precursor and product ions for MRM analyses
- Find compounds
- Identify compounds
- Do molecular feature extraction

Refer to the online Help for the Qualitative Analysis software to learn more.
Analyzing Data with Quantitative Analysis

Another primary tool for analyzing and reporting instrument results is the Quantitative Analysis program.

Do the exercises in the *Quantitative Analysis Familiarization Guide* to learn how to quantitate the acquired data files:

- Set up a batch and a method to automatically quantitate a set of samples
- Review results by learning how to view and use the Batch-at-a-Glance results screen
- Identify and use outliers to change the method and requantitate the data using a better calibration curve fit or other more appropriate settings

Refer to the online Help for the Quantitative Analysis program to learn how to do more operations to analyze your data.
5 Maintenance

Routine Tasks  61
Calibrant Delivery System and Divert Value  61
Sources  62
Nebulizer  65

Periodic Tasks  66
Calibrant Delivery System and Divert Value  66
Sources  67
Nebulizer  73
Corona Needle  78
Ion Injector  80
Rough Pump  83
Disinfection  89

When performing maintenance, it is recommended that you track procedures and details in a maintenance logbook.
Routine Tasks

Calibrant Delivery System and Divert Value

The following procedures describe routine maintenance tasks for the calibrant delivery system (CDS) and divert values.

**Checking calibrant levels**

Perform this procedure monthly or weekly if you tune the instrument frequently. Enough tuning mix must be present to immerse the end of the intake tube. If the tuning mix level is within a few millimeters of the end of the intake tube, refill the calibrant bottle.
Sources

The following procedures describe routine maintenance for the components that make up the source.

Cleaning the spray chamber - daily

Perform this maintenance daily or at the end of each shift or anytime you suspect carryover contamination from one sample or analysis to another.

Use the weekly cleaning procedure if symptoms of contamination persist or if the spray shield or capillary cap show significant discoloration that cannot be removed by the regular, daily cleaning.

Tools needed:
- Clean powder-free nitrile gloves
- Clean lint-free cloth
- LC/MS-grade isopropanol
- LC/MS-grade water
- Clean wash bottle

To perform daily cleaning of the spray chamber,
1. Put on clean powder-free nitrile gloves.
2. Lower the drying gas temperature to the minimum level.
3. For APCI/multimode, lower the vaporizer heater temperature to the minimum level.
4. In a clean wash bottle, prepare a 50:50 mix of LC/MS-grade isopropanol and LC/MS-grade water.
5. Open the spray chamber.
6. Dampen a clean lint-free cloth with a mixture of LC/MS-grade isopropanol and LC/MS-grade water.
7. Wipe the spray shield and the area around the spray shield.
8. Close the spray chamber.
Cleaning the spray chamber - weekly

Perform this maintenance weekly or whenever symptoms indicate that contamination exists in the spray chamber and normal daily cleaning does not correct the problem.

Tools needed:
• Clean powder-free nitrile gloves
• Clean lint-free cloth
• LC/MS-grade isopropanol
• LC/MS-grade water
• Clean wash bottle
• 4000 grit abrasive paper

To perform weekly cleaning of the spray chamber,
1 Put on clean powder-free nitrile gloves.
2 Disconnect the nebulizer sample line and sample nebulizer gas tubing from the nebulizer.
3 Disconnect all cables and tubings from the instrument.
4 Open the latch of spray chamber.
5 Open the spray chamber.
6 Put the source under a fume hood.
7 Dampen a clean lint-free cloth with a mixture of LC/MS-grade isopropanol and LC/MS-grade water. For Multimode, be careful not to touch thermocouple probe.
8 Wipe the interior of the spray chamber with a clean lint-free cloth.
9 Make sure you wear clean gloves. Use a tech wipe to hold the parts as you remove them. They will be warm.
10 Clean spray shield, capillary cap, end plate and contact ring under fume hood. Carefully remove the canted coil spring from the capillary cap before cleaning.
11 Use 4000 grit abrasive paper to clean contaminants from the parts.
12 Put the spray shield, capillary cap, end plates and contact ring in the beaker.
13 Add a 50:50 mix of LC/MS-grade isopropanol and LC/MS-grade water in a beaker.
14 Put the beaker in sonication for 5 minutes.
15 Drain the solvent and remove the parts from the beaker.
16 Dry the parts by using nitrogen gas.
17 Carefully insert the canted coil back into the capillary cap.
18 Reinstall the contact ring, end plate, capillary cap and spray shield.
19 Reinstall the spray chamber on the instrument.
20 Close the spray chamber.
21 Close the latch of spray chamber.
22 Connect all cables and tubings to the instrument.

**CAUTION**

Do not bend or blunt the tip of the needle, it will decrease system performance. Sharpening the needle is not needed.

23 Pull and twist the 4000 grit abrasive paper along the needle and off the tip of the needle.

**CAUTION**

Do not hit tip of the corona needle. The tip can bend, which can decrease system performance.

24 Starting at the base of the needle, wipe the needle with a clean lint-free cloth. The cloth can be dry or dampened with LC/MS-grade isopropanol.

**CAUTION**

Do not hit tip of the corona needle. The tip can bend, which can decrease system performance.

25 Connect the nebulizer sample line and sample nebulizer gas tubing to the nebulizer.
Nebulizer

The following procedures describe routine maintenance for the nebulizer.

**Flushing the nebulizer**

Check the nebulizer weekly. If needed, flush traces of samples and buffers out of the tubing, valves, and nebulizer.

Parts needed:
- LC/MS-grade methanol

To flush the nebulizer,

1. Install a mix of 30% to 70% methanol in water.
   On a monthly basis, prepare enough mix to flush overnight.

2. On a daily basis, flush for 3 minutes.
   On a monthly basis, flush overnight.
Periodic Tasks

Calibrant Delivery System and Divert Value

The following procedures describe periodic maintenance tasks for the calibrant delivery system (CDS) and divert values.

Filling a calibrant bottle

Perform this procedure as needed.

Parts required:
• APCI calibrant
• APCI-L tuning mix
• ESI-L tuning mix
• MMI-L tuning mix
• Reference mix

1 Rinse the calibrant bottle before refilling.
2 Refill the calibrant bottle with the appropriate tuning mix.
3 Put the intake tube into the calibrant bottle as you lift the calibrant bottle into position.

Do not touch the intake tube unless you are wearing clean gloves.

4 Attach the calibrant bottle onto the fixed bottle cap. Turn the calibrant bottle counter clockwise to tighten.

The bottle only needs to be snug. Do not over-tighten the bottle. A leaky bottle cap can prevent the bottle from pressurizing and can lead to the evaporation of the contents.

The tuning mixes are not interchangeable. Failure to change the tuning mix when the source or inlet assembly is changed can result in miscalibration of the instrument and errors in mass assignments.
Sources

The following procedures describe periodic maintenance for the components that make up the source.

Removing an Electrospray or Agilent Jet Stream source

Before you begin:
• Do a complete auto tune. If an auto tune is not available, do a check tune.
• If the tune report does not show good results, tune the instrument. If needed, change the source to one that supports auto tune.
• Put the system in Standby mode.

In the Tune view or context, turn down the gas temperature as low as possible. Leave the gas flow on for 30 minutes to cool the source.

1. For Electrospray (ESI), disconnect the nebulizer sample line.
2. For the dual ESI or dual AJS source on TOF and Q-TOF systems only, remove the second nebulizer. Disconnect the nebulizer sample line and sample nebulizer gas tubing.
3. Disconnect the heating cable.
4. Disconnect the sheath gas line at the connector and unplug it.
5. Disconnect the AJS HV cable delivering AJS nozzle voltage.
6. Disconnect the Multimode cable delivering AJS nozzle voltage.
7. Open the latch of spray chamber.
8. Open the spray chamber.
9. Remove the spray chamber by lifting it along the axis of its hinges.

The spray shield can be hot. Be careful not to burn yourself when you remove the spray shield.

10. If you are changing to a different source type, remove the spray shield.
Removing an APCI source

1. Put the system in Standby mode.

In the Tune view or context, turn down the gas temperature as low as possible. Leave the gas flow on for 30 minutes to cool the source.

2. Disconnect the nebulizer sample line.
3. Disconnect the sample nebulizer gas tubing.
4. Disconnect the heater cable.
5. Disconnect the corona needle voltage cable.

Removing a Mutlimode source

1. Put the system in Standby mode.

In the Tune view or context, turn down the gas temperature as low as possible. Leave the gas flow on for 30 minutes to cool the source.

2. Disconnect the nebulizer sample line.
3. Disconnect the heater cable.
4. Disconnect the charging electrode cable.
5. Open the latch of spray chamber.

**WARNING**
The spray chamber operates at very high temperature. Do not continue until the spray chamber is cool.

6. Remove the spray chamber by lifting it along the axis of its hinges.

**WARNING**
The spray shield can be hot. Be careful not to burn yourself when you remove the spray shield.

7. If you are changing to a different source type, remove the spray shield.
Installing an Electrospray or Agilent Jet Stream source

1. Check that the appropriate capillary cap is installed.
2. Install the appropriate spray shield.
3. For Electrospray (ESI), do the following:
   a. Make sure the small hole is at the top ("12 o'clock position").
   b. If needed, use a T10 Torx screwdriver to loosen the two screws in the end plate.
   c. Rotate the ESI spray shield clockwise until the hole is in the correct position.
   d. Gently tighten the Torx screws again.
4. Install the spray chamber.
5. Close the spray chamber.
6. Connect the MultiMode cable delivering AJS nozzle voltage.
7. Connect the heater cable.
8. Connect the sample nebulizer gas tubing.
9. Connect the nebulizer sample line.

**CAUTION**

Do not hit the tip of nebulizer needle. The needle is not protected. If you damage the needle, system performance can be affected.

10. Connect the reference nebulizer sample line and sample nebulizer gas tubing.

In the Data Analysis program,

1. In the Tune context, select the new ion source.
2. Turn on the LC/MS instrument.
3. While you wait for the set points to equilibrate, prepare and install calibrant for the new ion source.
   a. Rinse a clean calibrant bottle with LC/MS-grade acetonitrile.
   b. Pour the ESI Calibrant into the calibrant bottle.
   c. Install the calibrant bottle into the calibrant delivery system.
When all set points are equilibrated:

1. In the Tune view or context, turn on the calibrant.
2. Purge the calibrant line for 5 minutes.
3. Do a calibration. If calibration is not available, do a check tune.
4. If the check tune results are not acceptable, run auto tune on a supported tuning source.
5. When the instrument is ready, load or create the method to use with the ion source.
6. Change the method settings for the new ion source.

**Installing an APCI source**

1. Install the appropriate spray shield.
2. Make sure the small hole is at the top ("12 o'clock position").
3. If needed, use a T10 Torx screwdriver to loosen the two screws in the end plate.
4. Rotate the ESI spray shield clockwise until the hole is in the correct position.
5. Gently tighten the Torx screws again.
6. Install the spray chamber.
7. Close the spray chamber.
8. Close the spray chamber latch.
9. Connect the heater cable.
10. Connect the corona needle voltage cable.
11. Connect the sample nebulizer gas tubing.
12. Connect the nebulizer sample line.

In the Data Analysis program,

1. In the Tune context, select the new source.
2. Turn on the LC/MS instrument.
3. While you wait for the set points to equilibrate, prepare and install calibrant for the new source.
   a. Rinse a clean calibrant bottle with LC/MS-grade acetonitrile.
   b. Pour the APCI Calibrant into the calibrant bottle.
   c. Install the calibrant bottle into the calibrant delivery system.
When all set points are equilibrated:
1. In the Tune view or context, turn on the calibrant.
2. Purge the calibrant line for 5 minutes.
3. Do a calibration. If calibration is not available, do a check tune.
4. If the check tune results are not acceptable, run auto tune on a supported tuning source.
5. When the instrument is ready, load or create the method to use with the source.
6. Change the method settings for the new source.

**Installing a Multimode source**
1. Install the appropriate spray shield.
2. Make sure the dowels are at 6 and 9 o'clock positions.
3. Install the spray chamber.
4. Close the spray chamber.
5. Close the latch of spray chamber.
6. Connect the corona needle voltage cable.
7. Connect the charging electrode cable.
8. Connect the heater cable.
9. Connect the sample nebulizer gas tubing.
10. Connect the nebulizer sample line.

In the Data Analysis program,
1. In the Tune context, select the new source.
2. Turn on the LC/MS instrument.
3. While you wait for the set points to equilibrate, prepare and install calibrant for the new source.
   a. Rinse a clean calibrant bottle with LC/MS-grade acetonitrile.
   b. Pour the MMI Calibrant into the calibrant bottle.
   c. Install the calibrant bottle into the calibrant delivery system.
When all set points are equilibrated:
1  In the Tune view or context, turn on the calibrant.
2  Purge the calibrant line for 5 minutes.
3  Do a calibration. If calibration is not available, do a check tune.
4  If the check tune results are not acceptable, run auto tune on a supported tuning source.
5  When the instrument is ready, load or create the method to use with the source.
6  Change the method settings for the new source.
Nebulizer

The following procedures describe periodic maintenance for the nebulizer.

Removing the nebulizer

Perform this procedure when you need to access the nebulizer for maintenance.

Tools needed:
- Clean powder-free nitrile gloves

To remove the nebulizer,
1. Put on clean powder-free nitrile gloves.
2. In the Data Acquisition program, shut off the LC solve flow and nebulizing gas.
3. Remove the left side cover.
4. Disconnect the nebulizer sample line from the nebulizer.
5. Disconnect the sample nebulizer gas tubing from the nebulizer.

**WARNING**
The tip of the nebulizer can be very hot. Do not touch the nebulizer until it is cool.

6. Turn the nebulizer counterclockwise until it disengages from the retaining screws.
7. Gently lift the nebulizer out of the spray chamber.

Inspecting the nebulizer

Perform this procedure if you have the G1960-67470 Nebulizer Adjustment Kit. Perform this project if there is increased LC back pressure, off-axis spraying, dripping from the nebulizer, or when the reference nebulizer needle is not spraying.

Tools needed:
- Nebulizer Adjustment Fixture
- Clean powder-free nitrile gloves
- T6 Torx driver
- 1/4-inch x 5/16-inch open-end wrench (Quantity: 2)
Parts needed:
- Replacement needed kit

To inspect the nebulizer,
1. Put on clean powder-free nitrile gloves.
2. Determine your nebulizer type.
3. Carefully insert the tip of the nebulizer into the end of the Nebulizer Adjustment Fixture.
4. Slide the heads of the two spring loaded socket head cap screws through the mounting holes on the body of the nebulizer.
5. Turn the nebulizer body 1/8 turn counterclockwise.

**NOTE**
If the nebulizer is too tight or too loose, loosen or tighten the nut on the captured screws to adjust the tension on the spring. Turn clockwise to tighten, counterclockwise to loosen.

6. Gently push the 40 x Magnifier into the end horizontal position of the Nebulizer Adjustment Fixture. Align the tapered tip of the magnifier to the tip of the nebulizer needle.

7. Push the LED Flashlight into the Nebulizer Adjustment Fixture. No tool is needed.

8. Turn on the LED Flashlight. The on/off switch is at the end of the flashlight.

**CAUTION**
Do not hit or touch the end of the nebulizer or you can damage the needle.

9. Gently push the LED Flashlight into the end horizontal position of the Nebulizer Adjustment Fixture.

10. Push the 40 x Magnifier into the Nebulizer Adjustment Fixture. No tool is needed. Align the tapered tip of the magnifier to the tip of the nebulizer needle.

11. Turn on the LED Flashlight. The on/off switch is at the end of the flashlight.

**CAUTION**
Do not hit or touch the end of the nebulizer or you can damage the needle.
Gently slide and rotate the 40 x Magnifier into or out of the Nebulizer Adjustment Fixture to focus the magnifier on the end of the nebulizer nozzle and needle. For the APCI nebulizer, if needed, remove the pocket clip to focus properly.

Refer to Table 2 for correct needle position.

Table 2  Correct needle position

<table>
<thead>
<tr>
<th>Nebulizer</th>
<th>Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microflow Nebulizer Assembly</td>
<td>0.003 inch</td>
</tr>
<tr>
<td>ES Tested Nebulizer</td>
<td>0.000 (flush)</td>
</tr>
<tr>
<td>Tested ESI Nebulizer Assembly (older style)</td>
<td>0.003 inch</td>
</tr>
<tr>
<td>Tested APCI Nebulizer Assembly</td>
<td>0.000 (flush)</td>
</tr>
</tbody>
</table>

Adjusting or replacing the nebulizer needed

Perform this procedure if you have the G1960-67470 Nebulizer Adjustment Kit. Perform this project if there is increased LC back pressure, off-axis spraying, dripping from the nebulizer, or when the reference nebulizer needle is not spraying.

Tools needed:
• Nebulizer Adjustment Fixture
• Clean powder-free nitrile gloves
• T6 Torx driver
• 1/4-inch x 5/16-inch open-end wrench (Quantity: 2)

Parts needed:
• Replacement needed kit

To adjust or replace the nebulizer,
1. Put on clean powder-free nitrile gloves.
2. Determine the nebulizer holder type.
3. Install the nebulizer in the Nebulizer Adjustment Fixture.
4. Loosen the locknut next to the zero-dead-volume (ZDV) union.
5. Remove the union from the nebulizer needle holder.
6. Remove the union lock nut from the nebulizer.
7 Loosen the fastener (locknut, 1.5-mm hex screw or T6 Torx screw) that secures the needle holder in place.
8 Loosen the needle holder and pull it out of the nebulizer body. Dispose of the used needle properly.
9 For more thorough cleaning, sonicate the nebulizer body. Pour isopropyl alcohol or methanol through inside of the shaft.
10 Thread the new needle holder into the nebulizer body.
11 Carefully remove the new needle from the shipping tube and adhesive strip. Identify the sharp end of the needle.
12 Carefully slide the sharp end of the needle through the ferrule until 1 cm of the needle remains at the ferrule.

**CAUTION**
Do not bend the needle as you slide it into the ferrule. The needle is fragile. A bent needle results in poor alignment with the nebulizer body.

13 Push the needle into the ferrule until the needle is slightly visible flush with the ferrule.
14 Reinstall the locknut and the union. Hand-tighten the union.
15 Hold the needle holder steady with a 3-mm open-end wrench or 1/4-inch x 5/16-inch open-end wrench, depending on your nebulizer holder style.
16 Tighten the union one-half to three quarters of a turn, or until an audible squeak is heard.
   The ferrule is now compressed.
17 Pull carefully on the needle to ensure the needle is held firmly in place.
18 Insert the needle into the nebulizer shaft.
19 Adjust the electrospray needle position before reinstalling the nebulizer in the spray chamber.
20 Tighten the fastener (T6 Torx screw) that secures the needle holder in place.
Installing the nebulizer

1. Insert the nebulizer part way into the spray chamber.

**CAUTION**
Do not hit the tip of the needle as you insert the nebulizer. The tip of the needle is easily damaged.

2. Connect the nebulizer sample line to the nebulizer.
3. Turn the nebulizer clockwise and lock it in place.
4. Connect the sample nebulizer gas tubing to the nebulizer.

**CAUTION**
Do not over-tighten the LC fitting. An over-tightened fitting can crush the tubing, which creates a restriction.

Fixing Spray Stability EMF

If spray stability EMF is active, you should inspect, adjust or flush your nebulizer to ensure a stable spray from the CDS to the nebulizer. An unstable spray may lead to issues with tuning and sample analysis.

1. Inspect (page 73), adjust (page 75), or flush page 65 your nebulizer. If necessary, replace the nebulizer needle or nebulizer (page 75).
2. Follow the procedure to “Calibrating the LC/TQ (Checktune)” on page 30 or “Calibrating the LC/TQ (Autotune)” on page 31. The spray stability is reevaluated as part of a tune. If it within the acceptable range, the EMF warning should be removed following completion of the tune.
Corona Needle

The following procedures describe periodic maintenance for the corona needle.

**Cleaning the corona needle**

Perform this procedure when you observe decreased sensitivity, decreased signal stability, or increased corona voltage during APCI operation.

**Tools needed:**
- Clean powder-free nitrile gloves
- Clean lint-free cloth
- LC/MS-grade isopropanol
- 4000 grid abrasive paper

To clean the corona needle,

1. Put on clean powder-free nitrile gloves.

**WARNING**
The needle and related parts can be very hot. Do not touch the needle or related parts until they are cool.

2. Pull the corona needle assembly out of the spray chamber.

**CAUTION**
Do not bend or blunt the tip of the needle, it will decrease system performance. Sharpening the needle is not needed.

3. Fold a piece of 4000 grit abrasive paper over the base of the needle.

4. Pull and twist the 4000 grit abrasive paper along the needle and off the tip of the needle.

**CAUTION**
Do not hit tip of the corona needle. The tip can bend, which can decrease system performance.

5. Starting at the base of the needle, wipe the needle with a clean lint-free cloth. The cloth can be dry or dampened with LC/MS-grade isopropanol.

6. Reinstall the corona needle assembly in the spray chamber.
Replacing the corona needle

Perform this procedure when symptoms indicate poor corona needle performance and cleaning the needle does not restore performance.

Do not hit tip of the corona needle. The tip can bend, which can decrease system performance.

Tools needed:
- Clean powder-free nitrile gloves
- Corona needle

To replace the corona needle,
1. Put on clean powder-free nitrile gloves.
2. Pull the corona needle assembly out of the spray chamber.
3. Remove the needle collar from the corona needle shaft.
4. Remove the old corona needle from the collar.
5. Install a new corona needle, with its integral ferrule, in the collar.
6. Turn the collar onto the needle holder and tighten by hand.

Do not hit tip of the corona needle. The tip can bend, which can decrease system performance.

7. Reinstall the corona needle assembly in the spray chamber.
Ion Injector

The following procedures describes periodic maintenance for the ion injector. These procedures apply to both single and multi-bore ion injectors.

Removing the ion injector

Perform this procedure when you need to clean or replace the ion injector.

Tools needed:
- Clean powder-free nitrile gloves
- Capillary Puller Tool

**WARNING**
The spray chamber operates at very high temperatures. Do not continue until the spray chamber is cool.

To remove the ion injector,
1. Put on clean powder-free nitrile gloves.
2. Remove the ion injector cap from the end of the ion injector.
3. Screw the capillary puller tool fully into the spray shield mount.
4. Push the collet assembly over the ion injector and then tighten by holding the puller handle. Turn the collet clamping knob clockwise.
5. Pull on the knob until the collet assembly stops moving.
6. Visually check that the ion injector has been pulled out by the collet by looking through the slots on the tool.
7. Rotate the knob assembly counterclockwise slightly, and pull out the assembly to unlock the collet assembly from the puller.
8. Pull the tool out.

**CAUTION**
Carefully pull the ion injector out along its long axis. The ion injector is glass or of similar material, and you can break it by putting vertical or horizontal pressure on it.

9. Loosen the collet clamping knob slightly to loosen the ion injector from the capillary puller tool.
10. Pull out the ion injector from the collet.
11. Unscrew the tool from the shield mount.
Cleaning the ion injector

Perform this procedure when you observe decreased sensitivity and decreased signal stability.

Tools needed:
- Clean powder-free nitrile gloves
- LC/MS-grade isopropanol
- Alconox powdered precision cleaner
- Deionized (18 MΩ/cm) water
- 100-mL polypropylene graduated cylinder
- 10-mL polypropylene graduated cylinder
- Two 1-mL pipette tip

To clean the ion injector,

1. Put on clean powder-free nitrile gloves.
2. Dissolve 1 gram of Alconox Powdered Precision Cleaner in 100 mL of deionized (18 MΩ/cm) water. This concentration is the recommended concentration for both manual or ultrasonic cleaning.
3. If you use a glass graduated cylinder, cover the end of the ion injector with a 1-mL pipette tip to protect the metalized plating.
4. Trim the pipette tip to approximately 4 cm so that the ion injector can be immersed in the cleaning solution.
5. Place the ion injector upright in a graduated cylinder and fill with Alconox Powdered Precision Cleaner solution.
6. Put the Ultrasonic cleaner under a fume hood. Sonication should be done under a fume hood.
7. Sonicate the graduated cylinder that contains the ion injector in an ultrasonic cleaner for 10 to 15 minutes. Do not clean longer than 15 minutes.

Rinse the ion injector and graduated cylinder several times with deionized water.

8. Fill the graduated cylinder with deionized water and sonicate for 10 to 15 minutes.
9. Remove the ion injector from the graduated cylinder and remove the pipette tips (if any were used).
10. Blow out excess water from the ion injector bore with nitrogen.
Installing the ion injector

Perform this procedure after cleaning the ion injector or when installing a new ion injector.

Tools needed:
• Clean powder-free nitrile gloves
• LC/MS-grade isopropanol

To install the ion injector,
1. Put on clean powder-free nitrile gloves.
2. Lubricate the ion injector entrance end with LC/MS-grade isopropanol.
3. Carefully insert the ion injector straight into the desolvation assembly.

**CAUTION**
Putting vertical and horizontal pressure on the ion injector can break it. Spray ion injector with isopropanol alcohol to lubricate the ion injector for easier removal.

4. Slide the ion injector straight into the desolvation assembly.
   The ion injector must be aligned correctly so that its end fits into a fixed ion injector cap inside desolvation assembly.
5. When 2 to 3 cm of the ion injector against the rear contact spring, which slightly restricts further insertion of the ion injector. Slightly increase the insertion force to push the ion injector through the rear contact spring to fully insert the injector.
6. Continue to apply pressure until approximately 1 cm remains extended from the desolvation assembly.

**CAUTION**
Do not twist or turn the ion injector cap when you install it or you can damage the metal plating.

7. Install the contact ring and end plate.
8. Install the two T10 Torx screws to hold the end plate.
9. Lubricate the ion injector tip with LC/MS-grade isopropanol.
10. Install the ion injector cap over the outer end of the ion injector.
11. Install the spray shield.
12. Close the spray chamber.
Rough Pump

The following procedures describes periodic maintenance of the vacuum system of the instrument.

Checking the rough pump oil level

1. The oil level should be between the marks for Max and Min. Check that the pump oil is clear and the color is lighter than amber.
2. If the pump oil is dark or full of suspended particles, replace it.

Adding rough pump oil

Perform this procedure when the pump oil level is low.

Tools needed:
- Clean chemical-resistant gloves
- Safety glasses
- Funnel
- 10 mm hex key
- Paper towel or shop rag

Parts needed
- AFV 60 gold oil

WARNING
Wear chemical-resistant gloves and safety glasses (goggles) for your safety.

WARNING
Do not touch the fill cap or pump until they are cool. The fill cap and pump can be dangerously hot.

WARNING
Never add or replace the rough pump oil while the pump is on. Hot oil can splash out and cause harm.
Use only the rough pump oil appropriate for your pump (AFV 60 gold oil for Agilent MS40+). The use of any other oils can substantially reduce pump life and will invalidate the pump warranty.

To add rough pump oil,
1. Put on clean chemical-resistant gloves.
2. Place the instrument into 'Standby' then 'Vent'.
3. Allow the rough pump to turn off automatically, this should take about 15 minutes.
4. Unplug all power cords from LC/MS instrument.
5. Unplug the rough pump.
6. Remove the fill cap on the rough pump.
7. Add new AFV 60 gold oil until the oil level matches the maximum mark. Use a funnel.

Do not fill the oil over the maximum mark beside the oil level window.

8. Reinstall the fill cap.
9. Wipe off all excess oil around and underneath the pump.
Replacing the filter

Perform this procedure yearly.

Tools needed:
• Pair of pliers

Parts needed:
• Filter
• Filter cap O-ring
• Small cap O-ring

To replace the filter,
1 Place the instrument into 'Standby' then 'Vent'.
2 Allow the rough pump to turn off automatically, this should take about 15 minutes.
3 Unplug all power cords from LC/MS instrument.
4 Unplug the rough pump
5 Disconnect the exhaust tube.
6 Unscrew the filter cap.

CAUTION
The filter cap is spring loaded.

7 Remove O-ring from the filter cap.
8 Remove the old filter.
9 Remove O-ring from the filter.
10 Install the new small O-ring on the new filter and install the filter into the pump in the proper orientation.
11 The distance of filter should not be < 2 cm from outside cap thread.
12 Make sure the filter is > 2 cm from outside cap threads. When properly installed:
   • The filter cap is flush to the pump.
   • The back end of the filter is seated inside the filter mount.
13 Install the new large O-ring and filter cap.
14 Connect the exhaust tube.
15 Plug in the rough pump and all power cords from LC/MS instrument.
Replacing the rough pump oil

Perform this procedure yearly.

Tools needed:
- Clean chemical-resistant gloves
- Safety glasses
- Funnel
- 10 mm hex key
- Paper towel or shop rag
- Small plastic tub

Parts needed:
- AFV 60 gold oil

**WARNING**
Wear chemical-resistant gloves and safety glasses (goggles) for your safety.

**WARNING**
Do not touch the fill cap or pump until they are cool. The fill cap and pump can be dangerously hot.

**WARNING**
Never add or replace the rough pump oil while the pump is on. Hot oil can splash out and cause harm.

**CAUTION**
Use only the rough pump oil appropriate for your pump (AFV 60 gold oil for Agilent MS40+). The use of any other oils can substantially reduce pump life and will invalidate the pump warranty.

To replace the rough pump oil,

1. Put on clean chemical-resistant gloves.
2. Place the instrument into ‘Standby’ then ‘Vent’.
3. Allow the rough pump to turn off automatically, this should take about 15 minutes.
4. Unplug all power cords from the LC/MS instrument.
5. Unplug the rough pump.
6. Remove first the fill cap and then open the drain plug.
The rough pump is very heavy. Use care if you move or tip the pump.

7. Allow the oil to drain completely.
8. Reinstall the drain plug.
9. Add new AFV 60 gold oil until the oil level matches the maximum mark. Use a funnel.

Do not fill the oil over the maximum mark beside the oil level window.

10. Reinstall the fill cap.

### Replacing the HEPA filter element

1. Release the clamps of the HEPA filter canister.
2. Open the lid.
3. Remove the filter.
4. Insert new filter into the filter canister.
5. Close the lid.

Make sure the O-ring remains properly seated to cover to achieve the required vacuum. The vacuum performance can be determined only after the pump starts.

6. Fasten the clamps.
Replacing fuses or resetting circuit breakers

Perform this procedure as needed for maintenance.

Tools needed:
- Long flat-blade screwdriver
- 8 Amp fuse
- 12.5 Amp fuse

**WARNING**
Never replace a fuse while the instrument is plugged into the power outlet. You run the risk of an electric shock.

**CAUTION**
If the instrument is plugged in and turned on when you change a fuse, you will damage the instrument.

To replace fuses or reset circuit breakers,

1. Unplug the instrument power cord or cords from the power outlet.
2. If your LC/MS instrument includes circuit breakers and you need to reset them, press in the circuit breaker buttons.
3. Using a flat-blade screw driver, remove the fuse holder of the blown fuse.
4. Replace with the appropriate fuse.
5. Reinstall the fuse holder.
6. Plug in the instrument.
Disinfection

To prevent the spread of respiratory illness, disinfect your instrument as needed.

Equipment needed:
- Clean powder-free nitrile gloves
- Clean lint-free cloth
- Gown
- Isopropanol
- Mask

To disinfect your instrument,
1. Put on personal protective gear (gloves, mask, gown).
2. Make sure your instrument is cooled to room temperature.
3. Dampen a clean lint-free cloth with the 70:30 isopropyl alcohol:water mix.
4. Gently wipe external surfaces to be cleaned using moistened cloth. Do not allow any liquid to drip into the instrument.
5. Wipe the outer surface of cables and their connectors but do not touch the electrical connections (for example pins and plugs inside the cable or connection port).
6. Use one cloth per instrument to prevent cross contamination.
7. Dispose of the cloth appropriately.
8. Allow all surfaces to completely air-dry. No moisture should be present on the instrument surfaces.
9. Discard the gloves and other personal protective equipment or clean them in an approved process, then wash your hands.